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CChhaapptteerr  11::    IInnttrroodduuccttiioonn  

Thank you for purchasing an MES1A or MES1B Modbus TCP to 
Modbus ASCII/RTU Converter! Like all B&B Electronics products, this 
product has been manufactured to the highest standards of quality and 
performance to ensure your complete satisfaction.  

About this Manual 
This manual has been created to assist you in installing, configuring and 
using the MES1A/B. Please read it carefully and follow the instructions to 
achieve best results.  

Support 
For additional information on this and other B&B products, and for technical 
support, call 815.433.5100 option 3, or access B&B Electronics’ website at: 
www.bb-elec.com  

About Your MES1A/B Converter 
MES1A and MES1B Modbus TCP to Modbus ASCII/RTU Converters 
are easy-to-use, cost-effective solutions for connecting new and existing 
Modbus ASCII/RTU serial devices to TCP/IP networks. The MES1A 
provides this connection for Modbus devices with RS-232 interfaces; the 
MES1B facilitates Modbus devices with RS-422 four-wire point-to-point 
interfaces, or RS-485 four or two-wire multi-drop bus connections. 

 
Figure 1. MES1A and MES1B Converters 
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MES1A Converters allow new and legacy Modbus ASCII/RTU slave 
devices with RS-232 serial ports to operate on a TCP/IP network as full 
Modbus TCP slaves. All Modbus TCP devices on the network can share 
access to the Modbus ASCII/RTU device. 

MES1B Converters allow Modbus/RTU slave devices with RS-422/485 
interfaces to operate on a TCP/IP network as full Modbus TCP slaves. All 
Modbus devices on an RS-485 bus can be connected to the TCP/IP network 
via the MES1B, allowing them all to be accessed by Modbus TCP/IP devices 
on the network. 

Traditional Modbus ASCII/RTU master devices also can be connected to 
TCP/IP networks using the MES1A/B, making the device appear to be a full 
Modbus TCP master on the network. It can directly access Modbus TCP 
slave devices. It also can access other Modbus ASCII/RTU slaves that are 
connected to the network via other MES1A/B Converters, as if it is talking 
directly to a Modbus ASCII/RTU slave. 

Features 
• Converts Modus ASCII/RTU to Modbus/TCP 
• Small, economical and configurable 
• MES1A supports TD, RD and GND RS-232 lines 
• MES1B supports TDA(-), TDB(+), RDA(-), RDB(+) RS-422/485 lines 
• LEDs on network connection indicate link integrity and data transfer 

activity 
• 10/100 Mbps auto-detecting operation 
• Removable screw terminal strips for power supply 
• Removable screw terminal strips for RS-422/485 connection (MES1B) 
• Device Installer user interface software included 
• DIN rail mountable 
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CChhaapptteerr  22::    HHaarrddwwaarree  OOvveerrvviieeww  

Package Checklist 
MES1A/B Modbus ASCII/RTU to Modbus TCP Converters are 
shipped with the following items included: 

 the MES1A or MES1B module 
 a printed version of this user manual 
 a printed version of the MES1A/B Quick Start Guide 
 a CD-ROM disc with 

o Device Installer software 
o this manual in pdf format 
o a Quick Start guide in pdf format 

Indicators, Switches and Connectors  

Power LED  
The Power LED illuminates (red) immediately on power up 
indicating that 10 VDC to 30 VDC power is present on the Power 
Supply terminals. (Typically 12 VDC is used.) 

 
Figure 2. LED Indicators on the MES1A 
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Link LED  
When the Link LED located on the Ethernet jack is illuminated it 
indicates that a connection (link integrity) has been established 
between the converter and the network. Its color is green if 
connected to a 100BaseT network; orange if connected to a 
10BaseT network. It turns orange briefly during the power up 
process. 

Activity LED  
When the Activity LED located on the Ethernet jack is flashing 
(green) it indicates data is being sent across the network. This LED 
turns orange briefly during the power up process. 

LED Color/Status Function 

Power Red Power applied 

Link 
Orange 

Green 

Bootup, 10BaseT 

100BaseT 

Activity 
Green (Blinking) 

Orange 

Data on the network 

Bootup 

Figure 3. LED Status Table 

Reset Switch 
The Reset switch is accessible on the top edge of the MES1A/B 
(same edge as the power supply connector) through a small hole in 
the MES1A/B enclosure. It allows you to reset the MES1A/B by 
inserting a small tool through the hole and pressing the momentary 
switch for about 1 second. The MES1A/B restarts with its last saved 
configuration settings. 
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RS-422/485 Switch (MES1B only) 
The RS-422/485 switch allows you to set the MES1B Converter for 
RS-422/485 four-wire or RS-485 two-wire operation.  

• When the switch is in the left position, the MES1B operates in 
RS-422/485 four-wire mode.  

• When the switch is in the right position, the MES1B operates 
in the RS-485 two-wire mode.  

Ethernet Port Connector 
The Ethernet Port connector is a standard RJ-45 receptacle that 
allows the converter to be connected to an Ethernet network. Two 
indicator LEDs (described above) are built into the RJ-45 
connector.  

DB-9M Serial Port Connector (MES1A only) 
The Serial Port Connector on the MES1A is a DB-9 male 
connector (configured as a DTE) supporting RS-232 serial 
communications including TD (Pin 3), RD (Pin 2) and GND (Pin 5) 
signal lines. If the Modbus device you are connecting to the 
MES1A is configured as a DCE you will use a straight-through 
serial cable. If the Modbus device is configured as a DTE, use a null 
modem cable. 

Refer to Appendix D for connection pin-outs. 

RS-422/485 Connector (MES1B only) 
The RS-422/485 connector on the MES1B is a five position 
removable terminal block with screw downs. The connector 
provides screw connections for: 

• Terminal 1 - RDB(+) 
• Terminal 2 - RDA(-) 
• Terminal 3 - TDB(+) 
• Terminal 4 - TDA(-) 
• Terminal 5 – Ground 
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Figure 4. MES1B Serial Connector 

RS-422/485 Four-Wire Mode 
When the MES1B is configured to operate in RS-422/485 four-wire 
mode (RS-422/485 switch in the left position) its receive terminals 
are connected to the transmit terminals of the Modbus device it is 
communicating with. Its transmit terminals are connected to the 
receive terminals of the Modbus device it is communicating with. 

 

 
Figure 5. RS-422/485 Four-Wire Connection 

RS-485 Two-Wire Mode 
When the MES1B is configured to operate in RS-485 two-wire 
mode (RS-422/485 switch in the right position) the two-wire RS-
485 two-wire communications cable pair is connected to Terminals 
TDB and TDA. The communications cable ground/shield is 
connected to GND. 
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Figure 6. RS-485 Two-Wire Connection 

No jumpers are required to bridge the transmit and receive lines in 
two-wire mode. 

Power Connector 
The Power Connector is a removable two-position screw terminal 
block with screw down. The MES1A/B requires between 10 VDC 
and 30 VDC (3.6 Watts). Typically a 12 VDC power adapter is 
connected to the terminal block via bare wires. The terminal block 
can be unplugged to remove the converter from service. 

  
Figure 7. MES1A/B Power Connector 

Connecting the Hardware 
The MES1A is connected to its Modbus device via a DB-9M 
connector and an RS-232 cable. The MES1A is configured as a 
DTE. If the connected Modbus device is configured as a DCE, use a 
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straight-through cable. If the connected Modbus device is 
configured as a DTE, use a null modem cable. 

Always check the interface specifications of the Modbus device to 
determine whether it is a DTE or DCE  before connecting. 

The MES1B is connected to its Modbus device via the RS-422/485 
terminal block. In RS-422/485 four-wire mode a cable containing 
two pairs and a ground/shield is used. In RS-485 two-wire mode a 
cable containing one pair and a ground/shield is used. 

Power is supplied to the converter via the power supply terminal 
block.  

Typically, the MES1A/B is connected to the network via a hub 
switch or router using standard straight-through CAT-5 cable. (If 
you are connecting the MES1A/B directly to a PC’s network 
interface a crossover Ethernet cable is required.) 

 
Figure 8. MES1A Connections 
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Figure 9. MES1B Connections 
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CChhaapptteerr  33::    GGeettttiinngg  SSttaarrtteedd  

QuickStart 
The following section is a quick, step-by-step procedure that will 
assist you to get started configuring the MES1A/B. Additional 
details on how to use the Device Installer software to discover and 
connect to devices is included in the section following this one. 
MES1A/B configuration details are included in Chapter 4. 

1. Check the contents of your MES1A/B package. It should 
contain… 

 The MES1A or MES1B unit 

 A printed version of this user manual 

 A printed version of the MES1A/B Quick Start Guide 

 Software CD with Device Installer software, this manual, Quick 
Start guide 

2. Set up the Hardware  

 Connect the MES1A/B to the network using an Ethernet cable. 

  Connect your PC to the network 

 Connect a 12 VDC power supply (not included) to the MES1A/B 
and apply power. (10 to 30 VDC, 3.6 Watts.) 

3. Software Installation 

 Insert the software CD and it should auto-start into the 
installation wizard. 

 Follow the on-screen installation wizard to install the Device 
Installer software. 
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4. Discover the MES1A/B on the Network 

 Open the Device Installer software. It should detect the 
MES1A/B and display XPort in the third level of the Devices 
Tree. 

 Expand the Devices Tree and click the device IP Address. 

 Select the Telnet Configuration tab, then click Connect. 

 When the Modbus/TCP to RTU Bridge, MAC address and 
Software version information appears, Press Enter to go into 
Setup Mode. 

5. Configure the MES1A/B 

 To change the IP Address, Default Gateway or Netmask, type 1. 

 To configure Master/Slave and serial Interface settings, type 2. 

 Do not change any configuration settings in section 3. 

 To configure Modbus/TCP settings, type 4. 

 To configure Modbus Master settings, type 5. 

 To save your settings to the MES1A/B, type S. 

6. Modbus Device Installation 

 Connect the Modbus device to the serial interface on the 
MES1A/B using the correct cabling: 

 MES1A is a DTE: Use a straight through serial cable if the 
Modbus device is a DCE; null modem if device is DTE. 

 MES1B: Four-wire for RS-422, Two-wire for RS-485, Set 
RS-422/485 switch. 

 Your Modbus device should now be operational on the network. 

Note: The MES1A/B can be reset (rebooted) by pressing the 
Reset switch for one second. Reset switch is accessed through a 
small hole in the top of the enclosure. 
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Using the Device Installer Software 
This section provides more detailed information on how to install 
and use the Device Installer software. 

Device Installer is used to set up and configure the MES1A/B on a 
network. It detects all MES1A/Bs on the network and allows you to 
configure the network and serial port settings. It also allows you to 
monitor the MES1A/B and verify its status.  

System Requirements 
• Windows XP, Windows 2000, Windows NT4.0 (with service 

pack 6.0a or later), Windows ME, or Windows 98 
• Internet Explorer 5.01 or later 
• 30 MB hard drive space 
• 64 MB RAM 

Installing the Device Installer 

Note: Device Installer requires Microsoft .NET software to 
operate. 

To install the Device Installer software: 

1. Insert the CD included with your MES1A/B into the CD 
ROM drive of your PC. 

2. The installation should launch automatically. If not: 

a. Click Start on the Task Bar and select Run 

b. Type in [CD drive letter]:\Launch.exe 

3. When the Device Installer Setup Wizard dialog box 
appears, click Next to open the Select Installation Folder 
dialog box. 

4. Accept the suggested installation folder or click Browse… 
to select a different installation folder. 

5. Click Next to open the Confirm Installation dialog box. 

6. Click Next to begin the installation. When finished, the 
Installation Complete dialog box appears. 
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Starting the Device Installer 
Run the Device Installer from the Start, Programs, Lantronix, 
DeviceInstaller menu. 

Discovering Devices 
When Device Installer opens it automatically scans the network for 
MES1A/B devices.  

Any of the following steps will initiate a manual search for devices: 

• Click the Search icon 
• On the Device menu, click Search 
• Press the F5 function key 

When discovered for the first time, any MES1A/B devices present 
are listed in the Devices Tree pane and Device List pane as XPort 
and XPort IAP respectively. (XPort is the name of the internal 
module of the MES1A/B.) 

The Devices Tree shows a hierarchy including any network bridges 
under which the MES1A/B is found. 

The Device List pane is a table showing: 

• Device Type 
• Device Name 
• Group 
• IP Address 
• Hardware (MAC) Address 
• Status 
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Figure 10. The Device Installer Main Window 

Getting Device Details 
The Device Installer provides a variety of information about the 
MES1A/B under the Device Details tab.  

To access the Device Details tab: 

1. Expand the Device Tree by clicking the + symbol next to 
XPort. Keep expanding until the IP Address of the 
MES1A/B appears. 

2. Click the IP Address on the Device Tree. The Device 
Details tab appears where the Device List was. 

 
Figure 11. Device Details Tab 

Note: The Web Configuration tab is not used with the MES1A/B. 
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Connecting to the MES1A/B 
Before configuration can occur you must set up a telnet connection 
with the MES1A/B to access the Configuration Menu. You can 
access the Configuration Menu using a standard telnet window, or 
use the telnet implementation within the Device Installer software. 
The Device Installer option provides an all-in-one user interface for 
working with the MES1A/B 

To connect: 

3. Select the Telnet Configuration tab. The tab shows the IP 
Address of the MES1A/B and the Port Number used to 
communicate with it via telnet. The rest of the window is 
blank. 

4. Click Connect to connect to the MES1A/B.  When a 
connection is established the following window appears, 
which contains information on the MAC address and 
Software version of the MES1A/B.  

 
Figure 12. Press Enter to go into Setup Mode 

The background color of the window remains white for 
five seconds, then changes to gray when it times out.  

5. Press the Enter key within five seconds to go into Setup 
Mode or it will time out (and you will have to click Clear 
and repeat the process). 

The MES1A/B Configuration Menu appears. 
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Figure 13. Telnet Configuration Tab with Settings 

Refer to Chapter 4 for configuration details. 
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CChhaapptteerr  44::    CCoonnffiigguurriinngg  tthhee  MMEESS11AA//BB  

Configuration of the MES1A/B is accomplished from the Configuration 
Menu, which is accessed via a standard telnet window, or through the telnet 
implementation within the Device Installer software. 

Note: The Web Configuration tab is not used with the MES1A/B. 

 
Figure 14. Telnet Configuration Tab 
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Navigating the Configuration Menu 
On initial power-up there are four sections in the MES1A/B configuration 
menu. A fifth menu item appears if you are configuring a Modbus Master 
device. The menu items are: 

6. Network/IP Settings 

7. Serial & Mode Settings 

8. Modem/Configurable Pin Settings 

9. Advanced Modbus Protocol Settings  

The following menu item 5) appears if the MES1A/B is configured as a 
Modbus Master in section 2) Serial Protocol 

10. Unit ID to IP Address Table 

Each section of the configuration menu includes several parameters. 

11. Begin the configuration by typing the menu section number at the 
Select Command or parameter set (1..4) to change: 
prompt.  

The first configuration parameter of the section will appear at the 
bottom of the pane. The current setting is shown in brackets. 

Example: 

 
Figure 15. Setting the IP Address 

Download from Www.Somanuals.com. All Manuals Search And Download.



  Configuring the MES1A/B 

Manual Documentation Number: MES1A/MES1B-2106m        PN7138-rev001 
B&B Electronics Mfg Co Inc – 707 Dayton Rd - PO Box 1040 - Ottawa IL 61350 - Ph 815-433-5100 - Fax 815-433-5104 – www.bb-elec.com 

B&B Electronics Ltd – Westlink Commercial Park – Oranmore, Galway, Ireland – Ph +353 91-792444 – Fax +353 91-792445 – www.bb-europe.com 

21 

12. To change the parameter, type in a new value, then press Enter. If 
you wish to leave the parameter as it was, simply press Enter. A 
prompt for the next parameter will appear.  

13. When all parameters in the currently selected section are complete 
you will again be prompted to select a menu item. Select another 
section and continue the configuration process. 

Saving Configuration Settings 
When all categories have been configured you must save your configuration 
to the MES1A/B.  

To Save the configuration settings to the MES1A/B, at the Select 
Command or parameter set (1..4) to change: prompt type S.  

Quitting Without Saving 
To Quit the configuration session without saving, type Q. The background 
color will change to gray and the MES1A/B will re-start without updating the 
configuration settings. 

Reconfiguring to Factory Settings 
The MES1A and MES1B come from the factory preconfigured for correct 
operation with their respective interfaces. The following procedure describes 
how you can return the MES1A and MES1B to their original factory settings. 

To Reconfigure the MES1A to Factory Settings: 
Type D at the Select Command or parameter set (1..4) to 
change: prompt. The Configuration Menu is updated with the new settings 
displayed. 

To Reconfigure the MES1B, to Factory Settings: 
14. Type D at the Select Command or parameter set (1..4) 

to change: prompt.  

15. Type 2 to enter the Serial & Mode Settings section and set the 
Serial Mode for RS-485 Two-Wire (see the next section for 
details). 
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16. Type 3 to enter the Modem/Configurable Pin Settings section and 
set CP1 to RS-485 Enable Wire (see the next section for details).. 

See the following sections for details on how to set Serial & Mode Settings and 
Modem/Configurable Pin Settings. 

1) Network/IP Settings 
In the Network/IP Settings section of the Configuration Menu you can 
configure: 

• IP Address of the MES1A/B 
• Default Gateway 
• Netmask 
• Telnet Configuration Password 

IP Address 
Every device connected to a TCP/IP network must have a unique IP 
Address. This includes every MES1A/B. However, there is more than one 
way to set up an IP address for the MES1A/B 

DHCP 
The MES1A/B is shipped with a default IP address of 0.0.0.0. This 
configures the converter to obtain an IP address via DHCP (Dynamic Host 
Configuration Protocol) from a DHCP server on the network when the 
MES1A/B boots up.  

If a DHCP server is available to respond to the DHCP request, the MES1A/B 
will receive an IP address, gateway address and subnet mask from the server. 

A DHCP-generated IP address will appear in the Device Tree, Device List 
and at the top of the Telnet Configuration tab, but it will not be displayed 
in the IP Address field of the Network/IP Settings section of the 
Configuration Menu.  

 
Figure 16. Network/IP Settings Menu 
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Auto-IP 
If a DHCP server is NOT available on the network, the MES1A/B will revert 
to Auto-IP and generate its own IP address in the 169.254.xxx.xxx range. 

Static IP Address 
The IP address of the MES1A/B can be changed via the Telnet Configuration 
Menu interface.  

To determine an appropriate static IP address, consult your network 
administrator. The Device Installer Help feature also provides some useful 
information related to IP addressing. 

17. At the Select Command or parameter set (1..4) to 
change: prompt, type 1.  

18. At the IP Address (000)prompt 

o To keep the current setting, press Enter  
o To change the IP address, type the first octet 

 Press Enter to accept the change 
 Repeat for all octets 

19. Press Enter to accept the new IP address 

After the new settings have been accepted they will appear in the 
Configuration Menu. After the Configuration has been saved to the 
MES1A/B, the new settings will appear in the Device Details tab. 

The IP Address can also be changed from the Device Installer menu. See 
Chapter 5 for details. 

Default Gateway 
A Default Gateway address is only required if your MES1A/B must 
communicate with devices on remote TCP/IP networks through a router or 
gateway. The default value for this parameter is ---not set---. 

• If you DO NOT require remote communication, type N or just press 
Enter at the Set Gateway IP Address (N) prompt. 

• If you DO require remote communication through a router or gateway, 
type Y. The Gateway IP Address: (000) prompt appears. Enter the 
IP address of the default gateway within your local network by typing 
each address octet followed by pressing Enter. 
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After the new settings have been accepted they will appear in the 
Configuration Menu. After the Configuration has been saved to the 
MES1A/B, the new settings will appear in the Device Details tab. 

Netmask 
Typically you will type N, or just press Enter to cause the MES1A/B to 
automatically use the standard Netmask appropriate for the IP address being 
used. The default value for this parameter is ---not set---. 

To change the Netmask setting 

20. Press Enter to keep the current setting  

21. Press Y to change the setting 

22. At the prompt type in four octets representing the new Netmask.  

After the new settings have been accepted they will appear in the 
Configuration Menu. After the Configuration has been saved to the 
MES1A/B, the new settings will appear in the Device Details tab. 

For more information or direction on the netmask you may require, consult your 
network administrator.  

Telnet Configuration Password 
You can set up a Telnet Configuration Password to control unauthorized 
access to the Telnet Configuration interface. 

23. Type Y. The Enter New Password: prompt appears. 

24. Type in a password. The words Telnet config password set 
appears in the 1) section of the configuration menu. 

The default value for this parameter is N (for Not Set). 

Warning:  Do not forget your password if used.  There is no easy way to get 
into the unit for configuration once you forget your password. 

2) Serial and Mode Settings 
In the Serial and Mode Settings section of the Configuration Menu you can 
configure: 

• the serial Protocol to be used with your Modbus device 

Download from Www.Somanuals.com. All Manuals Search And Download.



  Configuring the MES1A/B 

Manual Documentation Number: MES1A/MES1B-2106m        PN7138-rev001 
B&B Electronics Mfg Co Inc – 707 Dayton Rd - PO Box 1040 - Ottawa IL 61350 - Ph 815-433-5100 - Fax 815-433-5104 – www.bb-elec.com 

B&B Electronics Ltd – Westlink Commercial Park – Oranmore, Galway, Ireland – Ph +353 91-792444 – Fax +353 91-792445 – www.bb-europe.com 

25 

• the Serial Interface type and communications parameters 

 
Figure 17. Serial & Mode Settings Menu 

To configure Serial and Mode Settings, type 2 at the Select Command or 
parameter set (1..4) to change: prompt. The Attached Device 
prompt appears. 

Protocol 
Protocol parameters must be set to match the type of Modbus device (master 
or slave) connected to the serial side of the MES1A/B device, and the type of 
Modbus protocol (ASCII or RTU) that will be used.  

Attached Device 
Modbus devices operate as either Masters (polling Slaves) or Slaves 
(responding to polls from Masters). An example of a Modbus master is a 
computer running HMI (human machine interface) software. Examples of 
Modbus slaves are controllers, remote terminal units (RTU) or programmable 
logic controllers (PLC).   

To configure the type of Attached Device: 

25. At the Attached Device (1=Slave 2=Master)(1) prompt 

o To keep the current setting, press Enter  
o To select Slave, type 1 
o To select Master, type 2  

26. To accept changes, press Enter  

Note: When Master mode is selected a fifth item (Unit ID -> IP Address Table is 
added to the Configuration Menu.  

Serial Protocol 
Modbus devices communicate in either of two Serial Protocols: ASCII or 
RTU. Modbus/ASCII protocol is slower and uses two ASCII characters to 
represent each 8 bit data byte. Modbus/RTU uses 8 bit binary data characters. 
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The MES1A/B must be configured to use the same protocol used by the 
attached Modbus device. 

To configure the type of Serial Protocol 

27. At the Serial Protocol (1=Modbus/RTU 2=Modbus/ASCII) 
(1) prompt  

o To keep the current setting, press Enter  
o To select Modbus/RTU, type 1  
o To select Modbus/ASCII, type 2 

28. To accept changes, press Enter  

Serial Interface 
Serial Interface parameters include the type of interface and the data 
rate/format of the data. The MES1A/B must use the same type of interface 
and serial parameters as that of the Modbus device it is connected to. 

MES1A Serial Interface 
Since the MES1A is designed with an RS-232 interface, its default Interface 
Type is RS-232.  

Although RS-422/485 four-wire and RS-485 two-wire options are given in the 
configuration menu, reconfiguring the MES1A for anything other than RS-232 
will prevent the device from operating correctly. 

MES1B Serial Interface 
The MES1B is designed with an RS-422/485 interface and can be configured 
for four-wire operation or two-wire operation.  

Although RS-232 option is provided in the configuration menu, reconfiguring the 
MES1B for RS-232 will prevent the device from operating correctly. 

To configure Interface Type parameters: 

29. At the Interface Type (1=RS232 2=RS422/RS485+4-wire 
3=RS485+2-wire) (3) prompt: 

o To keep the current setting, press Enter  
o To select RS-422/RS-485 four-wire, type 2  
o To select RS-485 two-wire, type 3  
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30. To accept changes, press Enter  

When RS-422/485 four-wire operation is selected: 

When RS-422/485 four-wire operation is selected the RS-422/485 switch 
on the MES1B must be in the left position. 

When RS-485 two-wire operation is selected: 

• CP1 (configured in the next section under Modem/Configurable Pin 
Settings) must be enabled to ensure Send Data control is implemented. 

• The RS-422/485 switch on the MES1B must be in the right position.  
• The multidrop bus is connected to Terminals 3 [DataB(+) to TDB(+) 

terminal] and 4 [DataA(-) to TDA(-) terminal]. 
• No jumpers are required to bridge transmit and receive lines on the 

terminal block 

Serial Parameters 
MES1A/B Serial Parameters must be set up to match the parameters of the 
Modbus device connected to its serial interface. MES1A/B Serial Parameter 
options include: 

• Data rates from 300 bps to 115200 bps 
• 7 or 8 data bits 
• No, Even or Odd parity 
• 1 or 2 stop bits. 

To configure Serial Parameters: 

31. At the Enter serial parameters (9600,8,N,1)prompt  

o To keep the current setting, press Enter  
o To change the serial parameters, type in new parameters in the 

format 9600,8,N,1 

32. To accept changes, press Enter  

3) Modem/Configurable Pin Settings 
There is only one configurable setting required in the Modem/Configurable 
Pin Settings section of the Configuration Menu. When configuring an 
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MES1B for RS-485 two-wire operation, the CP1 parameter must be set for 
RS485 Enable to ensure Send Data Control is implemented. 

No configuration is required in this section for MES1A converters. 

To configure RS485 Enable in the Modem/Configurable Pin Settings 
section: 

33.  Type 3 at the Select Command or parameter set (1..4) 
to change: prompt. The CP1 Function prompt appears. 

34. Type 4 to select RS485 Enable 

35. To accept the change, press Enter 

36. Press Enter three more times to exit the Modem/Configurable Pin 
Settings section of the Configuration Menu. 

4) Advanced Modbus Protocol Settings 
In the Advanced Modbus Protocol Settings section of the Configuration 
Menu you can configure: 

• whether the Slave Address is fixed or used as received 
• whether to Allow Modbus Broadcasts 
• whether to Use MB/TCP 00BH/00AH Exception Responses 
• whether to Disable Modbus/TCP Pipeline 
• Character Timeout values 
• Message Timeout values 
• Serial TX delay after RX values 
• whether to Swap 4x/0H to get 3x/1x register conversions 

 
Figure 18. Advanced Modbus Protocol Settings Menu 
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Slave Address / Unit ID Source 
All devices connected to a TCP/IP network require a unique IP address. Each 
MES1A/B Converter has a unique IP address on the network, allowing 
messages to be directed to it. However, when multiple Modbus/RTU devices 
are connected to the RS-485 bus of an MES1B there must be a way to 
address them individually.  

Standard Modbus/RTU fields are encapsulated inside Modbus/TCP 
messages. Modbus/RTU’s Slave Address field is called the Unit ID in 
Modbus/TCP. The Unit ID is used to specify a particular Modbus/RTU 
device on the serial side of the MES1A/B. When the MES1A/B receives a 
message (sent to its IP address), it looks at the Unit ID field of the message 
and passes the message to the specified slave.  

0 for Auto 
Setting the Slave Address field to 0 allows the MES1A/B to use the Unit ID 
received from a Modbus master to direct messages to a specific slave 
address. The MES1A/B receives the Unit ID number on the Modbus/TCP 
side and passes it along as the Slave Address on the serial side of the 
converter. 

1…255 
Unfortunately, some early Modbus/TCP products assumed that each IP 
address would have only one slave. These products always set their Unit ID 
to 0 (relying on the IP address only to address the slave). The lack of an 
appropriate Unit ID presents a problem for the MES1B. It must include a 
Slave Address in its messages to Modbus/RTU slaves. 

To overcome this problem, the MES1A/B Slave Address field can be set to 
the address of one Modbus/RTU slave (any number in the range of 1 to 255). 
This limits the number of slaves that can be connected to the MES1A/B to 
one, but ensures that when any message for the MES1A/B’s IP address is 
received (regardless of its Unit ID), it is passed along to the slave.  

To configure the Slave Address field: 

• If Modbus TCP masters on your system use appropriate Unit ID 
addresses, select 0. You will be able to connect multiple Modbus/RTU 
slaves with RS-485 interfaces to an MES1B. 
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• If any Modbus TCP masters on your system use 0 for all Unit ID fields, 
select a slave address that matches the Modbus/RTU slave attached to 
your MES1A/B. You will not be able to connect multiple slaves to the 
RS-485 multidrop bus. 

Allow Modbus Broadcasts 

If you configured the Slave Address for any number between 1 and 255 the 
Allow Modbus Broadcasts does not appear in the menu. 

When a Modbus/RTU slave receives a slave address of 0 it interprets this as a 
broadcast message. All slaves accept the message. Setting the Allow 
Modbus Broadcasts (1=Yes, 2=No)to No reassigns a Unit ID of 0 from 
a Modbus TCP master as a slave address 1. This ensures that a Unit ID is not 
interpreted as a broadcast message. 

Use MB/TCP 00BH/00AH Exception Responses 
In Modbus/RTU, when a master initiates a query it expects to receive a 
response. If it does not receive one within an acceptable length of time it 
interprets the silence as an indication that a communications error has 
occurred. Because delays in TCP/IP networks are not predictable, problems 
can occur. To address this, Modbus/TCP defines two exception codes that 
can be enabled to be sent in the event of a communications failure. 

1 = No 
If Use MB/TCP 00BH/00AH Exception Responses (1=No 2=Yes)is 
disabled (1=No), the MES1A/B operates like a Modbus/RTU slave. It 
answers timeouts, un-configured slave addresses and CRC errors with 
silence. 

2 = Yes 
If the Use MB/TCP 00BH/00AH Exception Responses (1=No 
2=Yes)is enabled (2 = Yes), the MES1A/B will return the following codes 
under any of the conditions described: 

0A (hex) - Path Unavailable 

• If it receives a query from a Modbus master in which the Unit ID 
specifies a Slave Address not listed in the Unit ID to IP Mapping Table  

• If the TCP socket fails to open. 
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0B (hex) - Target Device Failed to Respond 

• If the slave did not answer, or the answer contained a CRC error 
• If a TCP socket is open, but no response is received within the defined 

message timeout period 
• If a TCP socket is open, but the remote Modbus TCP slave/server 

returned exception 0B (hex) 

Disable Modbus/TCP Pipeline 
Typically a Modbus master issues a query and waits for a response before 
issuing another. However, when using Modbus/TCP, multiple queries can be 
issued and the MES1A/B will buffer them in a “pipeline”. The MES1A/B 
can fetch each query one at a time, and respond. In some situations this is 
useful, but in others the sequence of query/response can get out of sync 
(especially if any queries or responses are lost). The Disable Modbus/TCP 
Pipeline setting allows you to decide how you want the system to operate. 

• Setting this field to 1 = No configures the MES1A/B to allow pipeline 
operation. This is considered the safest default setting. It is 
recommended that you choose this option unless you are experiencing 
problems. 

• Setting this field to 2 = Yes configures the MES1A/B to always fetch the 
latest request from the TCP buffer (discarding all older requests).  

Character Timeout 
Although Modbus/RTU specifies a 3.5 character time out period between 
characters, the Character Timeout field allows you to set a custom value for 
this field.  

• If you set this field to 0, the MES1A/B will automatically calculate a 
minimum timeout based on the baud rate being used.  

• Although you can set this field to any value between 1 milliseconds and 
6959 milliseconds, a recommended safe value for general use is about 50 
milliseconds (which is the default value). 

Message Timeout 
The Message Timeout field allows you to set the timeout period for 
responses from a connected slave to any value between 200 milliseconds and 
65000 milliseconds. The default value is 5000 milliseconds. 
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Serial TX Delay after RX 
When the MES1A/B receives a request from a master it relays the request to 
the Modbus slave connected to the MES1A/B’s serial connection. When the 
slave responds a timer is triggered and, after the delay time configured in the 
Serial TX Delay after TX field, the next master request is allowed to pass 
through the serial connection to the slave. When using 2-wire RS-485 
connections, this delay value can be set to ensure that RS-485 devices have 
time to disable their drivers and enable their receivers to receive the next 
request. Typically this is not a concern and the default value is 0. The delay 
can be set to a maximum of 1275 milliseconds. 

Swap 4x/0H to Get 3x/1x 
This field allows you to configure the MES1A/B to convert holding register 
(4x) data to input register (3x) data, and convert coil (0x) data to contact (1x) 
data. This is useful when connecting to Modicon I/O scanners. 

5) Unit ID to IP Address Lookup Table Settings 
The Configuring Unit ID to IP Address Table Settings section of the 
Configuration Menu becomes available if the MES1A/B has been configured 
as a Modbus Master in Configuration Menu section 2).  

From Configuration Menu section 5) you can configure: 

• whether to Close Idle TCP Sockets after a specified number of seconds 
• whether to enable Redundant entry retries after a specified number of 

seconds 
• the Unit ID to IP Address Lookup Table 

 
Figure 19. Unit ID -> IP Address Table Settings Menu 

Close Idle TCP Sockets After 
The Close Idle TCP Sockets After field allows you to configure 
whether a socket is held open, or the number of seconds to hold the last 
socket open.  
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• If you configure this field for 0 it hold a single socket open to the last 
remote Modbus TCP slave accessed 

• If you configure this field for any value between 3 and 60 seconds, it 
will close the last socket after the configured length of idle time. 

Redundant Entry Retries After 
The Redundant Entry Retries After field allows you to disable 
redundant retries or set a maximum length of time for retries. 

• If you configure this field for 0 is disables the feature. 
• If you configure this field for any value between 15 seconds and 60 

seconds it will set the retry period to the configure time. 

Add, Delete, Exit  - Select Function 
The Add, Delete, Exit - Select Function field is the starting point 
for managing entries in the IP Address Table.   

• Type A to add an entry. The Modbus addr from prompt appears. 
• Type D to delete an entry. The Delete entry number prompt 

appears. 
• Type E to exit. 

Modbus Address From/To 
Configuring these fields sets up the range of Modbus slave addresses that 
will be forwarded to the IP address (that you will configure in the next step).  

The prompt: Modbus addr from (1) indicates that no slave addresses 
have been added to the list so far. If other slave addresses have already been 
configured, the number will reflect the first available slave address number. 

37. Press Enter to accept (1) as the first slave address number, or type 
in the number you prefer. After you press Enter, the Modbus 
Address To prompt appears. 

38. Type in an slave address number that reflects the range of slaves 
that will be found at the IP address that will be entered in the next 
step. When you press Enter the Slave IP address prompt 
appears. 
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Slave IP Address 
Type in the four octets of the IP address of the slaves being addressed. 

• If you configure the last octet as 000 the MES1A/B will use the Slave 
Address/Unit ID of the slave as part of the IP address. This allows a 
Modbus/RTU master (connected through the MES1A/B) to access up to 
255 remote Modbus TCP slaves. 

• If you configure the last octet for a number between 1 and 254, all slave 
polls in this group will be sent to the same IP address. 
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CChhaapptteerr  55::    UUssiinngg  OOtthheerr  DDeevviiccee  IInnssttaalllleerr  
FFeeaattuurreess  

In addition to the capabilities already mentioned, the Device Installer 
software provides other important and useful features. This section provides 
a brief overview of those features. For more information, access the Help 
files from the main menu. 

Device Installer features which are not used or supported by the MES1A/B 
include: 

• Console Mode (via Serial port) configuration 
• Recover Firmware (Tools menu, Advanced selection) 
• Web Configuration  

Managing Device Lists 
This section included information on how to: 

• Create a New Device List 
• Save a Device List 
• Open a Device List 
• Configure Device List Display Options 

Creating a New Device List 
To create a new Device List, on the File menu, select New. The Device 
Installer software will create a new list but will not initiate a search to 
discover devices on the network.  

To initiate a search, select Search On the Device menu, click the Search Icon or 
press F5.  
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Saving Device Lists 
After a list of MES1A/B devices has been discovered on the network, you 
can save the list, including details such as the Device Name, Group, 
Comments and IP Address.  

To save a Device List, On the File menu, select Save or Save As, type in a 
file name of your choice and click Save. 

Note: The configuration of the MES1A/B is NOT saved using this method. To 
store the configuration in the MES1A/B, on the Telnet Configuration Menu, set 
up the configuration, then type S at the Default settings, Save, 
Quit without Save prompt. To store the configuration in a Setup 
Record file see the procedure later in this chapter. 

Opening Device Lists 
To open an existing Device List, on the File menu, select Open. In the Open 
dialog box that appears, select or type in a file name and click Open. 

The MES1A/B will search for all devices listed in the Device List file and 
display them in the Devices Tree. Devices not listed in the Device List file 
will not be shown. To discover other devices not already on the list you must 
initiate a search. 

Device List Display Options 
Device Installer provides several options for displaying devices in the Device 
Tree and List.  

Display Devices Using Icons 
• On the View menu, select Device List, then select Icons.  

 
Figure 20. Device List Icon View 
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Display the Hardware (MAC) Address 
• On the View menu, select Device Node Text, then select Hardware 

Address. 

 
Figure 21. Device Node Hardware Address View 

Display the Device Name  
• On the View menu, select Device Node Text, then select Name. 

 
Figure 22. Device Node Name View  

Adding a Device Manually 
Although you will typically discover MES1A/B devices on the network 
using the Search tool, you can also add a device to the network manually. To 
do so you must know the IP address of the device. 

 
Figure 23. Add Device Dialog Box 
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To manually add a device to the Device List:  

39. On the Device menu, select Add Device. 

40. In the Add Device dialog box, type the IP address of the device. 

41. Click OK 

• If a device with that IP address is not found on the network a dialog box 
will appear indicating Device at [IP address] was not found! 

• If a device is found it will be listed in the Device Tree and the Device 
Details tab for the device appears. 

Assigning an IP Address (using Device Installer) 
The MES1A/B can obtain its IP address in several ways: 

• Via DHCP when it is first connected to the network (See Chapter 4) 
• By changing the IP address from the Telnet Configuration Menu (See 

Chapter 4) 
• Using the Assign IP feature of the Device Installer software 

Using Device Installer to Assign an IP Address 
To use Device Installer to Assign an IP address: 

42. Click the Assign IP icon, press F7, or on the Device menu, select 
Assign IP Address. The Assign IP Address wizard appears. 

If a specific MES1A/B device is not selected in the Devices Tree, 
the first page of the wizard will ask for the Hardware (MAC) 
Address of the device to be configured. You will find the Hardware 
Address of your particular MES1A/B on a sticker attached to the 
device. Type the Hardware Address into the wizard and click next. 

43. Since the MES1A/B is pre-configured to use DHCP (its IP address 
is pre-configured for 0.0.0.0 which causes it to use DHCP). 
Therefore, do not use the Obtain an IP address automatically 
option in the wizard. 

44. If you wish to assign a different IP address to the MES1A/B, select 
Assign a specific IP address and click Next. The IP Settings page 
of the wizard appears. 

45. Type the desired IP address into the appropriate text box. 
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46. If required, type the Subnet Mask and Default Gateway addresses 
into the appropriate text boxes. 

47. Click Next. The Assignment page of the wizard appears. 

48. Click Assign. A Progress of task bar graph appears. When the 
process is Completed successfully, click Finish. 

49. The new IP address appears in the Devices Tree, Device Details tab 
and Telnet Configuration tab. 

Using the Devices Details Tab 
The Device Details tab provides useful information about the MES1A/B 
currently selected in the Device List.  

 
Figure 24. Device Details Tab 

Although most fields in are fixed, the Name, Group and Comments fields 
are user configurable, allowing you to add information specific to your 
application. 

To change any of these fields, double-click the field, then type your text into 
the text box that appears. 
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Figure 25. Adding Info to the Device Details Tab 

Upgrading Firmware 
From time to time updated firmware versions for the MES1A/B may become 
available (from the B&B Electronics website). Device Installer provides a 
Device Upgrade Wizard which can be used to install updated firmware into 
the MES1A/B.  

To install firmware in the MES1A/B: 

On the Device menu, select Upgrade…, or click the Upgrade icon. The Device 
Upgrade Wizard – Step 1 of 5 dialog box appears. 

 
Figure 26. Device Upgrade Wizard Step 1 

50. If an Installation File (lxi) has already been created, select Use a 
specific installation file (LXI) (previously saved by user) 

51. If an Installation File has not been created, select Create a custom 
installation by specifying individual files (Typical) and then click 
Next. 

52. In the Device Upgrade Wizard – Step 2 of 5 dialog box, browse to 
find the Firmware (ROM, SYS & SPB) File, then click Next. 
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53. In the Device Upgrade Wizard – Step 3 of 5 dialog box, select No 
other files to install (typical), then browse and select the 
previously saved Setup file.  

54. In the Device Upgrade Wizard – Step 4 of 5 dialog box, click 
Next. The Device Upgrade Wizard – Step 5 of 5 dialog box 
appears and displays a bar graph indicating progress. Succeeded 
appears next to a listing of each step as it is accomplished. 

 
Figure 27. Device Upgrade Wizard – Step 5 of 5 

Installing Pre-Saved Configuration Files 
The same wizard can be used to install previously saved configuration 
settings (Setup Records) into the MES1A/B. This can be useful if you want 
to configure multiple MES1A/Bs with the same settings, or if you must 
replace an MES1A/B and want to load identical settings into the new unit.  

To use the Upgrade Wizard to install configuration setting in an MES1A/B 
you must first save the settings in the form of a Setup Record.  

Saving Setup Records 
To save the Setup Records for a particular device (MES1A/B) 

55. Select the device in the Device List. 

56. On the File menu, select Save Setup Records. The Save Setup 
Records dialog box appears. 
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Figure 28. Save Setup Records Dialog Box 

57. Select a Setup Record from the list and click Save. The Save As 
dialog box appears.  

58. Create a filename and click Save. 

Installing Setup Records 
To install a Setup Record in the MES1A/B: 

59. On the Device menu, select Upgrade…, or click the Upgrade icon. 
The Device Upgrade Wizard – Step 1 of 5 dialog box appears. 

 
Figure 29. Device Upgrade Wizard Step 1 

60. Select Create a custom installation by specifying individual files 
(Typical) and then click Next. 

61. In the Device Upgrade Wizard – Step 2 of 5 dialog box, click 
Next. 
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62. In the Device Upgrade Wizard – Step 3 of 5 dialog box, select 
Install setup records from a file, then browse and select the 
previously saved Setup file.  

63. In the Device Upgrade Wizard – Step 4 of 5 dialog box, click 
Next. The Device Upgrade Wizard – Step 5 of 5 dialog box 
appears and displays a bar graph indicating progress. Succeeded 
appears next to a listing of each step as it is accomplished. 

 
Figure 30. Device Upgrade Wizard – Step 5 of 5 

Configuration settings stored in the Setup file will now appear in the Telnet 
Configuration Menu. 

Logging Search and Upgrade Data 
Device Installer provides a logging feature that can be used to record and 
store information on the process of searching for devices or upgrading the 
MES1A/B.  

64. To enable logging select Options… on the Tools menu. The 
Options dialog box opens. 

Download from Www.Somanuals.com. All Manuals Search And Download.



Using Other Device Installer Features 

Manual Documentation Number: MES1A/MES1B-2106m        PN7138-rev001 
B&B Electronics Mfg Co Inc – 707 Dayton Rd - PO Box 1040 - Ottawa IL 61350 - Ph 815-433-5100 - Fax 815-433-5104 – www.bb-elec.com 

B&B Electronics Ltd – Westlink Commercial Park – Oranmore, Galway, Ireland – Ph +353 91-792444 – Fax +353 91-792445 – www.bb-europe.com 
     44 

 
Figure 31. Options Window, Customization Tab 

65. On the Customization tab, select Activate logging during 
upgrading and Activate logging during searching. (Both must be 
selected to allow logging during search.) 

66. In the Log File text box, type the path and name of the log file, or 
browse and create a file name in the folder of your choice. 

67. Click OK to accept the changes and close the Options dialog box. 

68. Click the Search icon to initiate a Search for devices on the 
network. 

69. When the search is complete, select Log File on the View menu. 
Notepad opens and displays the log file. The log file contains the 
date and time for each entry.  

 
Figure 32. Log File in Notepad 
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Using Ping 
Device Installer provides the convenience of implementing the Ping network 
utility from within the Device Installer window. Ping provides the option of 
checking to see whether messages can be sent to and received from a device 
on the network at a specified IP address. It also provides information on the 
time required for responses from the device. 

To open the Ping Device window, select Ping on the Tools menu, or press 
F4. Type the IP address of the network device you want to ping, then press 
Enter or click the Ping button. Click the Clear Status button to clear the 
Status area. 

 
Figure 33. Ping Device Window  

Using Help 
You can access Device Installer Help files by selecting Contents on the Help 
menu. 

 
Figure 34. Device Installer Help 
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CChhaapptteerr  66::    MMooddbbuuss  BBaassiiccss  

If you are reading this manual you are probably in the process of interfacing 
legacy Modbus ASCII/RTU devices to a network. Chances are you already 
have some knowledge and familiarity with Modbus ASCII/RTU but possibly 
somewhat less knowledge of Modbus/TCP and/or networking in general. 
Most likely your biggest questions relate to what is involved in bringing the 
two together.  

This section provides: 

• a basic introduction to Modbus 
• some information on Modbus/TCP 
• some tips and suggestions for ensuring success 

Modbus ASCII/RTU 
The Modbus protocol emerged in the mid-1970s as an early protocol for 
linking terminals with Modicon PLCs using a master/slave (sometimes called 
a master/client) relationship. A simple, open, message-based protocol, it 
caught on quickly and became a defacto standard in the industry. It supports 
asynchronous point-to-point and multidrop communications and can be used 
with a variety of serial interfaces (RS-232, RS-422, RS-485, modems, etc).  

The original Modbus specification included two possible transmission 
modes: ASCII and RTU. Modbus RTU mode is the most common 
implementation, using binary coding and CRC error-checking. Modbus 
ASCII messages, though somewhat more readable because they use ASCII 
characters, is less efficient and uses less effective LRC error checking. ASCII 
mode uses ASCII characters to begin and end messages whereas RTU uses 
time gaps (3.5 character times) of silence for framing. The two modes are 
incompatible so a device configured for ASCII mode cannot communicate 
with one using RTU. 

All Modbus communications are initiated by Modbus masters using a 
polling, query/response format. The master can send broadcast messages 
(using a slave address of 0), which all slaves accept, but do not reply to. 
More commonly the master polls individual slaves sequentially. In each poll 
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it sends a message containing a device address, followed by a function 
code, any data that maybe required, and an error check field. The addressed 
slave responds with a similar message structure. Typically it repeats back its 
address and the function code, and then sends a field indicating the number 
of bytes of data it is sending, followed by the data and the error check field.  

Slave addresses can range from 1 to 247. Function codes include several 
common ones typically used in all applications, and additional ones that may 
be implemented in specific cases. Common function codes include: Read 
Coil Status (01), Read Input Status (02), Read Holding Registers (03) and 
Read Input Registers (04). 

When a master sends a message to a slave it expects to receive a valid 
response within certain length of time. If the slave does not receive the 
message, or if the slave receives the message but an error is detected, it does 
not respond. If the slave cannot respond appropriately for some other reason 
(e.g. it does not recognize the function code), it will return a message 
containing an exception response.  

Modbus/TCP 
Modbus/TCP is a much more recent development, created to allow Modbus 
ASCII/RTU protocol to be carried over TCP/IP-based networks. 
Modbus/TCP embeds Modbus messages inside TCP/IP frames. Although the 
implementation is fairly simple, characteristics associated with networking 
add some challenges. For example, because Modbus masters expect and 
require responses to their polls within a certain time frame, the non-
deterministic (and other) aspects of TCP/IP networks have to be considered. 

Modbus/TCP sets up connections between nodes on the network, sending 
requests via TCP in a half-duplex fashion. TCP allows multiple requests to 
be ‘pipelined’, or queued in a buffer waiting to be serviced. Modbus/TCP has 
the capability to use transaction identifiers (sequence numbers), but some 
early manufacturers of Modbus/TCP equipment did not use them. In some 
cases this can create problems for Modbus/RTU devices connected to the 
network through interfaces. If a request from a master is lost, or contains an 
improper function code, the slave does not respond. The master may re-
initiate the request, or there may be other requests in the pipeline. Responses 
to later, or other, requests may become out of sync and the master may match 
the wrong response with a request. The resulting symptoms could range from 
appearing to receive wrong data from a slave, to slaves going off-line, to a 
gradually slowing down of response time.  
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Another aspect of Modbus/TCP that must be considered relates to the Unit 
ID field. Modbus/RTU incorporates the slave address field but Modbus/TCP 
replaces the slave address field with a Unit ID field. TCP/IP uses IP 
addresses to find specific nodes on the network. By using the IP address to 
specify the node, and the Unit ID to specify a Modbus/RTU device attached 
to that node, multiple slaves can be located at a single IP address. 
Unfortunately, some manufacturers of early Modbus/TCP systems assumed 
only one slave per IP address and always used a Unit ID of 00. If this early 
equipment is used, only one Modbus/RTU slave can be connected to an 
MES1A/B. (The MES1B is capable of RS-485 multidrop, allowing multiple 
slaves.) 

Hints and Tips 
A few simple suggestions that may assist you if your system is experiencing 
problems include: 

• Slow down the polling rate.  
• Try the Disable Pipeline option in the MES1A/B configuration menu. 
• Make sure your Modbus/TCP equipment uses sequence and Unit ID 

numbers. 
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AAppppeennddiixx  AA::  DDeeffaauulltt  CCoonnffiigguurraattiioonn  
SSeettttiinnggss  

IP Address: 0.0.0.0 /DHCP/BOOTP/AutoIP 

Gateway IP Address: Not set 

Netmask: Not set 

Telnet Configuration Password: Not set 

Attached Device: Slave 

Serial Protocol: Modbus/RTU, Slave 

Interface Type: MES1A – RS-232 
MES1B – RS-422/485 

Serial Parameters: 9600, 8, N, 1 

CP1 Function: MES1A - Not used 
MES1B – RS-485 Enabled 

CP2 Function: Not used 

CP3 Function: Not used 

Slave Address: 0 (auto maps to 1) 

Allow Modbus Broadcasts: 2 (no) 

Use MB/TCP 00BH/00AH Exception Responses: 2 (yes) 

Disable Modbus/TCP pipeline: 1 (no) 

Character Timeout: 50 milliseconds 

Message Timeout: 5000 milliseconds 

Serial TX delay after RX: 0 milliseconds 

Swap 4x/0H to get 3x/1x: No 
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AAppppeennddiixx  BB::    PPrroodduucctt  SSppeecciiffiiccaattiioonnss  

Models: MES1A, MES1B  

Manual: Paper copy of this manual, PDF available 

CD-ROM disc: XPort Device Installer software 
PDF of MES1A/MES1B User Manual 
PDF of Quick Start guide 

Operating Systems supported Windows 98/ME/2000/XP/NT 4.0 
(call B&B Tech Support for other operating systems) 

Dimensions MES1A/MES1B – 1.25 x 4.5 x 4.75 in (3.2 x 11.3 x 12.2 cm) 

Power Supply Requirements: 10 VDC to 30VDC (3.6 Watts) 

Power Supply: Not included 

Power Connector: Removable  screw terminal (2) block with screw down 

Power Consumption: 3.6 Watts (12VDC @ 300 mA) 

Operating Temperature: -20 to 80 °C (-4 to 176 °F) 

Storage Temperature:   −40 to 85 °C (−40 to 185 °F) 

Humidity:   10% to 90% R.H. non-condensing 

Approvals: CE, FCC Class B 

Link Integrity Indicator: Green/Orange LED (on Ethernet connector) 

Activity Indicator: Green/Orange LED (on Ethernet connector) 

Power Indicator: Red LED 

Reset Switch Recessed momentary switch, press for 1 second to reboot (hardware 
reset) 

Ethernet Connector: Single RJ-45 female (with built-in LED indicators) 

Ethernet Standards Supported: IEEE 802.3 10/100 Mbps auto-detecting, 10BaseT, 100BaseTX 

Protocols Supported: TCP, UDP, DHCP, SNMP, TELNET, ICMP, ARP, TFTP, Modbus ASCII, 
Modbus RTU, Modbus/TCP 

Serial Protection: 12V TVS for MES1A 
5 V TVS for MES1B 

Serial Connector: MES1A - 9 pin D-type male (DB-9M) 
MES1B – removable screw terminal (5) block with screw down 
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Interface Lines Supported: MES1A – RS-232 TD, RD, GND 
MES1B – RS-422/485 TDA(-), TDB(+), RDA(-), RDB(+), GND 

Serial Data Rates: 300, 600, 1200, 2400, 3600, 4800, 9600, 19200, 38400, 57600, 115200 
bps 

Parity: None, Even, Odd 

Data Bits: 7 or 8 

Stop Bits: 1, 2 

Flow control: None 

Configuration Modes: Telnet,  XPort Device Installer with integrated Telnet 

Device Management: SNMP – RFC 1213/1215/1316/131 

IP Address Assignment: Static IP or DHCP (IP is set to 0.0.0.0) 

Accessories: DIN/Panel mount bracket 
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AAppppeennddiixx  CC::    DDiimmeennssiioonnaall  DDiiaaggrraammss  

 

 

 
Figure 35. Dimensional Diagram of the MES1A 
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Figure 36. Dimensional Diagram of the MES1B 
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AAppppeennddiixx  DD::    SSeerriiaall  CCoonnnneeccttiioonnss  

 

DB-9M 
Pin 

Signal RS-232 DTE 

2 Receive Data  RXD In 
3 Transmit Data TXD Out 
5 Signal Ground GND --- 

Figure 37. RS-232 Connections for DB-9 Connector 

 

Signal Name Label Direction Terminal 
Receive Data (+) RDB(+) In 1 
Receive Data (-) RDA(-) In 2 
Transmit Data (+) TDB(+) Out 3 
Transmit Data (-) TDA(-) Out 4 

Signal Ground GND --- 5 

Figure 38. MES1B Terminal Block Pin-out for RS-422/485 Four-Wire 
Operation 
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Signal Name Label  Direction Terminal 
Not used Not 

used 
- 1 

Not used Not 
Used 

- 2 

DataB (+) TDB(+) In/Out 3 
DataA (-) TDA(-) In/Out 4 

Signal Ground GND --- 5 

Figure 39. MES1B Terminal Block Pin-out for RS-485 Two-Wire 
Operation 
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AAppppeennddiixx  EE::    NNeettwwoorrkk  CCoonnnneeccttiioonnss  

 
RJ-45 Pin Signal Wire Color RJ-45 Pin 

1 TX+ White-Green 1 

2 TX+ Green 2 

3 RX+ White-Orange 3 

4 Not used Blue 4 

5 Not used White-Blue 5 

6 RX- Orange 6 

7 Not used White-Brown 7 

8 Not used Brown 8 

Figure 40. Pin-out for a Standard Ethernet Cable 
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DECLARATION  OF  CONFORMITY 
Manufacturer’s Name: B&B Electronics Manufacturing Company 

Manufacturer’s Address: P.O. Box 1040 

 707 Dayton Road 

 Ottawa, IL 61350 USA 

Model Numbers: ESR901WB 

Description: 1 Port 802.11b Wireless Serial Server [       
Type: Light industrial ITE equipment 

Application of Council Directive: 89/336/EEC 

Standards: EN 55022 

 EN 61000-6-1 

 EN 61000 (-4-2, -4-3, -4-4, -4-5, -4-6, -4-8, -4-11) 

 

 

Michael J. Fahrion, Director of Engineering 
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